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(Foreground):Radioactive western blot detected using storage phosphor imaging and a PhosphorImager. 
Six bands have been outlined for analysis using the ImageQuant Auto Tracer tool. 

The magnifier tool provides a closer view of the first band. 
The volume report shows the results for the 6 objects.

(Background): Fluorescent amplified fragment length polymorphism (AFLP) imaged with the FluorImager. 
Lines have been drawn through adjacent lanes for comparison of the banding pattern. 

Line graphs of each lane are shown merged to analyze relative band positions and intensities. 
The cursor position in the graph window corresponds to the line marker on the image.
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Preface

Purpose of Tutorial
The ImageQuant Tutorial briefly steps you through some key 
functions of the ImageQuant software.

The tasks in this tutorial show you how to—

• Open the ImageQuant software 
• View and optimize an image
• Create objects and then use them for volume quantitation
• Select reporting options
• View the results of the volume quantitation
• Create a line graph and then use it for area quantitation
• View the results of the area quantitation
• Close ImageQuant 

Related Publications
In addition to the ImageQuant Tutorial, Molecular Dynamics 
provides the following:

• The ImageQuant User’s Guide—A step-by-step guide for all major 
functions of the ImageQuant software.

• The ImageQuant Reference—A reference, by menu item, for each 
command in the ImageQuant software.

• The ImageQuant Utilities User’s Guide—A guide that describes 
how to use the FluorSep™ and ImageQuant Tools utilities.

• A user’s guide for the Molecular Dynamics instrument.

Assumptions
The software-related instructions in this tutorial assume you 
have basic computer skills. You should be familiar with either 
the Microsoft Windows NT or the Apple Mac OS™ graphical user 
interface. If you do not have these skills, refer to the Windows NT 
or Mac OS documentation, or refer to the online Help for these 
operating systems. 
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Terms Used in This Tutorial
The following terms are used in this tutorial:

• Click—Press and then quickly release the mouse button.

• Drag—Hold down the mouse button while moving the mouse.

• Double-click—Press and release the mouse button twice.

• Point—Move the mouse until the pointer is positioned on the 
desired object.

• Pointer—An object, such as an arrow, that moves on the screen 
as you move the mouse.

Note: Unless stated otherwise, mouse button instructions refer 
to the left mouse button when using the Windows NT operating 
system.

Convention
In general, the figures used in the ImageQuant Tutorial display screen 
captures of the Windows NT version of ImageQuant. For clarity, 
some figures may display both the Windows NT and Macintosh® 
versions of ImageQuant.
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  Assistance

                
Assistance
If you have problems, please contact—

United States
Molecular Dynamics World Headquarters, Sunnyvale, CA
Telephone (1) (800) 743-7782 or (1) (408) 773-1222
Fax (1) (408) 773-0152
Ask for Technical Support.

United Kingdom
Molecular Dynamics Ltd., Buckinghamshire
Telephone (44) (1494) 793377, Fax (44) (1494) 793222

Germany
Molecular Dynamics GmbH, Krefeld
Telephone (44) (2151) 83870, Fax (44) (2151) 838740

France
Molecular Dynamics S.A., Paris
Telephone (33) (1) 6086-6513, Fax (33) (1) 6086-6533

Japan
Molecular Dynamics Japan, Inc., Tokyo
Telephone (81) (3) 5350-3211, Fax (81) (3) 5350-3654

Other Countries
Please call your Molecular Dynamics distributor or representative. 
If you need the name and number of your representative, 
please contact Molecular Dynamics World Headquarters at 
(1) (408) 773-1222, Fax (1) (408) 773-0152.

Web Site
www.mdyn.com
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 Welcome to ImageQuant
The ImageQuant software is a powerful image analysis package. 
It analyzes data collected on your Molecular Dynamics instrument. 
With ImageQuant, you can—

• Display a scanned image
• Detect, characterize, and quantitate objects
• Analyze data resulting from quantitation

This tutorial provides a brief look at some of the capabilities of 
ImageQuant. The ImageQuant User’s Guide and the ImageQuant 
Reference provide a complete description of ImageQuant.
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Step 1 Opening ImageQuant
The procedure for opening ImageQuant varies depending on the 
computer you are using.

Windows NT

To open ImageQuant in Windows NT, you double-click the 
ImageQuant shortcut icon on the desktop. If you did not create 
a shortcut, choose ImageQuant from the Start menu.

Macintosh

To open ImageQuant on a Macintosh, locate and double-click 
the ImageQuant icon. The ImageQuant icon is in the ImageQuant 
folder, which is in the MD Apps folder.

After you open ImageQuant, the procedures are identical for both 
computers.

Notice the status bar on the bottom of the screen. Throughout
the tutorial, messages will be displayed in the status bar. Toolbars 
also appear on the screen. The figure on the facing page shows the 
functions available on the toolbars. You will use the toolbars and 
menus to select commands.

Note: If you do not see all the toolbars shown on the facing page, 
choose Toolbars from the View menu. In the Toolbar Configuration 
window, click all the empty check boxes in the Toolbars portion of 
the window, and then click OK. You should see all the toolbars on 
the screen. The toolbars can appear at different locations on the 
screen.
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Step 1  Opening ImageQuant

        
Is ImageQuant open? Are the toolbars displayed? Go to the next page…
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- Save

- Print 

- Cut 

- Copy

- Paste 

- Help

- Select

- Rotate 

- Line 

- Polyline

- Rectangle

- Polygon

- Ellipse

- Region

- Grid

- Text Annotation

- Pan

- Pixel Locator 

- Pixel Distance

- Create Frame

- Previous Frame

- Magnifier

- Map 

- Gray/Color Adjust

- Select

- Create Frame 

- Previous Frame

- Split Graphs 

- Merge Graphs

- Maximize Graph

- Restore Graphs

- Split Peaks

- Define Peaks

Main Toolbar Object ToolbarImage Toolbar

Graph Toolbar

- Fit to Window

- Define Region of Interest - Auto Tracer

Multichannel Toolbar

Channel 1
Channel 2

Channel 3
Channel 4

Side-by-Side

Overlay

View Single Channel- Create Graph

- Area Review

- Volume Review

Quantitation Toolbar
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Step 2 Displaying the Image
ImageQuant includes an image, named Western, for you to use 
during this tutorial. Normally, you would display an image that 
you scanned on your Molecular Dynamics instrument.

To display the Western image—

1. Choose Open from the File menu. The Open window displays 
the contents of the Data folder.

2. Locate and double-click the Tutorial folder.

3. Locate and double-click the Western.ds file. The image appears 
in an Image window.

The image always appears scaled to fit in the Image window. 
ImageQuant provides tools to make your image easier to see. In 
the following steps, you will use a few of these tools.
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Step 2  Displaying the Image

        
Is the Western image displayed? Go to the next page…

Windows NT Macintosh
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Step 3 Optimizing the Display
You can use the Gray/Color Adjust feature to optimize the image 
display. In this step, you will change the High and Low display 
levels to darken the bands and lighten the background. You use the 
preview image at the top of the Gray/Color Adjust window to view 
the changes before applying them to the image.

To change the display levels—

1. Click the Gray/Color Adjust button in the Image toolbar to open 
the Gray/Color Adjust window.

2. Move the pointer to the High slider and drag the slider until the 
bands in the preview image begin to turn red.

3. Move the pointer to the Low slider and drag the slider until the 
background in the preview image begins to turn blue.

4. Click OK. The changes appear in the image in the Image 
window and the Gray/Color Adjust window closes.
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Step 3  Optimizing the Display

        
Are the bands darker and the background lighter? Go to the next page…

Gray/Color Adjust Button

Drag Sliders.
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Step 4 Creating a Rectangle
Before you can quantitate, you must identify the bands on the image 
that you want to analyze. You do this by drawing an object around 
each band. Several object types are available for this task. You are 
going to use the rectangle. 

To draw a rectangle—

1. Click the Rectangle button on the Object toolbar.

2. In the image, position the pointer at the upper-left corner of the 
first band in the second lane. Use the figure on the facing page to 
help identify the band.

3. Hold down the mouse button and drag the pointer until the 
band is surrounded by a rectangle. 

4. Release the mouse button. ImageQuant draws the rectangle
and adds handles. (Handles are the squares that appear on the 
rectangle to indicate that the rectangle is selected.)

5. You stay in the rectangle draw mode until you select another 
command. To end the rectangle draw mode, click the Select 
button on the Object toolbar.

If your rectangle does not look like the one on the facing page, you 
can delete it and try again. To delete the rectangle, click anywhere 
within the rectangle to select it, and then click the Cut button ( ). 
A window appears asking you to confirm that you want to delete 
the rectangle. Click Yes. Repeat the steps on this page to create a 
new rectangle.
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Step 4  Creating a Rectangle

        
Is the rectangle drawn? Go to the next page…

Rectangle Button
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Step 5 Duplicate the Rectangle
To compare several bands on the image, you need to create 
additional rectangles. Instead of creating new rectangles, you
can duplicate the rectangle you have already created. 

To create additional rectangles—

1. Make sure the Select button on the Object toolbar is selected.

2. Position the pointer in the middle of the rectangle.

3. Hold down the mouse button and press the v key on the 
keyboard.

4. Without releasing the mouse button, move the pointer until the 
rectangle surrounds the next band in the lane.

5. Without releasing the mouse button, press the v key again and 
move the rectangle to the next band.

6. Continue to duplicate the rectangle until you have six rectangles 
numbered 2 through 7.

7. Move the original rectangle (the one with the handles) to a 
different part of the image. Release the mouse button.

8. Click Cut ( ) to delete rectangle number 1. A window appears 
asking you to confirm that you want to delete the rectangle. 
Click Yes.

You should have six rectangles surrounding the six bands in the 
second lane, similar to the picture on the facing page.

If your rectangles do not surround the bands like those on the facing 
page, you can move them. To reposition a rectangle, click the 
rectangle to select it, and then drag the rectangle until it surrounds 
the band.
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Step 5  Duplicate the Rectangle
Are the rectangles created and positioned correctly? Go to the next page…
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Step 6 Reviewing the Volume Results
Immediately after you draw an object, you can view the results 
calculated for that object. You view the results for one object at
a time.

To do this—

1. Make sure the Select button on the Object toolbar is selected.

2. Position the pointer on one rectangle and click the mouse button. 
Handles appear at the corners to show that the object is selected.

3. Click the Volume Review button on the Quantitation toolbar, or 
choose Volume Review from the Analysis menu. The results for 
the selected object appear in the Volume Review inspector.

4. Select a different rectangle. The results for that object appear in 
the inspector.
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Step 6  Reviewing the Volume Results
Finished reviewing the results? Go to the next page…

Volume Review Button

Results for the selected rectangle appear 
in the Volume Review inspector.
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Step 7 Changing the Background Correction 
Method

Now you will apply a different background correction method. 
Five background correction methods are available. You will use 
Local Average, which uses the average pixel value found in the 
outline of each rectangle as the background value. When you assign 
a new background correction method to an object, ImageQuant 
automatically recalculates the volume of the object.

To select a background correction method and quantitate—

1. Choose Background Correction from the Analysis menu. The 
Background Correction inspector appears.

2. Position the pointer on the first rectangle displayed in the 
Objects list and drag the pointer past all the rectangles. All the 
rectangles should be selected. 

3. Click Local Average.

4. Click Set.

5. In the Image window, click to select a rectangle.

6. Click the Volume Review button on the Quantitation toolbar to 
view the results for the selected rectangle.

7. To review the results for another rectangle, click the rectangle.
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Step 7  Changing the Background Correction Method
Changed the background correction and viewed the results? Go to the next page…

Background Correction Inspector

Volume Review Button

Volume Review Inspector
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Step 8 Selecting Reporting Options
Before you print or display a report, you must tell ImageQuant 
which object properties you want reported. The options selected 
when the window opens are defaults. You can select or deselect 
any option.

1. Choose Volume Report Setup from the Analysis menu. The 
Volume Report Setup window appears.

2. Select the following Results options:

• Object Name
• Volume
• Percent
• Background Value
• Background Type
• Area

A check mark in the box means that the option is selected. Click 
a check box to select or deselect an option. 

3. Click OK to close the window and accept the settings.
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Step 8  Selecting Reporting Options
Have you selected your reporting options? Go to the next page…
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Step 9 Printing a Volume Report
In this step, you will print a report about the rectangles you created. 

To do this—

1. Choose Volume Report from the Analysis menu. The Volume 
Report inspector appears. 

2. Select the rectangles that you want to appear in the report.

3. Make sure that a check mark appears in the box in front of Print. 

4. Click the Report button. The report is sent to the printer.
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Step 9  Printing a Volume Report
Are your results printed? Go to the next page…
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Step 10 Creating a Line
Next you will perform an area quantitation. You perform an area 
quantitation by drawing a line object on the lane of interest. 

Note: If the rectangles are in the way, you may want to delete them. 
To do this, select the rectangles and click Cut ( ). A window 
appears asking you to confirm that you want to delete the 
rectangles. Click Yes.

To create the line—

1. Click the Line button on the Object toolbar.

2. Position the pointer at the top of the second lane. Use the figure 
on the facing page to determine where to begin and end the line.

3. Drag the pointer down the center of the lane. 

4. Release the mouse button when the line extends beyond the last 
band in the lane.

5. To end the line draw mode, click the Select button on the Object 
toolbar.
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Step 10  Creating a Line
Is the line displayed? Go to the next page…

Line Button
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Step 11 Adjusting the Width of the Line
Instead of using a one-pixel-wide line, you can change to a wide 
line. A wide line improves the quantitation by averaging the pixels 
on either side of the line.

To change to a wide line—

1. Choose Object Attributes from the Object menu. The Object 
Attributes inspector appears.

2. Position the pointer on the Width Each Side box, and double-
click. The number in the box is highlighted.

3. Type 20 in the box.

4. Click the Set button.

5. Close the Object Attributes inspector by clicking the close box in 
the inspector.

The dashed lines move to the edges of the bands. Make sure that the 
dashed lines do not extend past the edges of the bands. If they do, 
ImageQuant will average in background values.
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Step 11  Adjusting the Width of the Line
Is the wide line within the edges of the bands? Go to the next page…

Type 20. Click Set.
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Step 12 Creating a Line Graph and 
Quantitating

The first step in area quantitation is to create a line graph of the 
pixel locations and pixel values. After the line graph appears, you 
can use the parameters in the Peak Finder inspector to perform the 
quantitation. The results are immediately available in the Area 
Review inspector. 

Before creating the line graph, resize the Image window so that you 
see only the wide line. You may need to use the horizontal scroll bar 
to display the line.

To create a line graph and quantitate—

1. Make sure the line is selected on the image.

2. Click the Create Graph button on the Quantitation toolbar. A 
line graph appears in the Graph window.

3. Move the Graph window so that you can see the line displayed 
in the Image window.

4. Choose Peak Finder from the Analysis menu. The Peak Finder 
inspector appears.

5. Make sure the Display and Print check boxes are not selected. 

6. Click Compute. The line graph changes to show the found peaks 
and the automatic baseline. 

7. Choose Area Review from the Analysis menu. The Area Review 
inspector appears showing the results for one peak.

8. In the Graph window, click to display a vertical hairline. As you 
drag the hairline, notice a matching marker in the Image 
window.
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Step 12  Creating a Line Graph and Quantitating
Viewed the line graph and peak results? Go to the next page…

Marker on Image for Peak 15

Peak Finder Inspector Click Compute.

Area Review Inspector
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Step 13 Changing the Peak Finder Parameters
Because the default Peak Finder parameters may not be the most 
useful for your sample, you may need to change the parameters. 
You can adjust six different parameters to improve the peak finding 
results. In this step, you will change the Minimum Area value, 
which eliminates peaks that represent noise instead of relevant data.

To adjust the parameters—

1. Choose Peak Finder from the Analysis menu. The Peak Finder 
inspector reappears.

2. Click the Minimum Area box and type 700.  This removes peaks 
with an area of less than 700.

3. Click Compute. The peaks and the automatic baseline reflect the 
changes you made to the Peak Finder parameters.

ImageQuant automatically analyzes all peaks in the line graph.
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Step 13  Changing the Peak Finder Parameters
Viewed the baseline and peaks? Go to the next page…

Type 700.
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Step 14 Selecting Reporting Options
Before you print or display an area report, you must tell 
ImageQuant which results you want reported. The options selected 
when the window opens are defaults. You can select or deselect
any option.

1. Choose Area Report Setup from the Analysis menu. The Area 
Report Setup window appears.

2. Select the following Results options:

• Peak Number
• Area
• Percent
• Apex
• Separation

A check mark in the box means that the option is selected. Click a 
check box to select or deselect an option. 

3. Click OK to close the window and accept the settings.
28 IMAGEQUANT TUTORIAL



Step 14  Selecting Reporting Options
Have you selected your reporting options? Go to the next page…
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Step 15 Printing an Area Report
Now you can print an area report.

1. Choose Area Report from the Analysis menu. The Area Report 
inspector appears. 

2. Select the line graph that you want to appear in the report.

3. Make sure that a check mark appears in the box in front of Print. 

4. Click the Report button. The report is sent to the printer.
30 IMAGEQUANT TUTORIAL



Step 15  Printing an Area Report
Printed the area report? Go to the next page…
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Step 16 Closing ImageQuant
You have successfully completed several ImageQuant tasks. Before 
you end your tutorial session, you need to close the Western image. 
Normally, you would save your objects and results. However, 
because this is a tutorial, you will want to leave the tutorial in the 
same condition you found it. 

To do this—

1. Choose Close All from the Window menu. 

2. For each open window, a pop-up window appears asking if you 
want to save. Click No.

3. When all the windows are closed, choose Exit or Quit from the 
File menu to close ImageQuant.
32 IMAGEQUANT TUTORIAL



Step 16  Closing ImageQuant
Congratulations!

Windows NT
Macintosh
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